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lekcija 1

 

Osnove Dreamweavera 
MX 

 

2004

 

Dreamweaver MX 

 

2004

 

 je program za izradu Web strana, koji omoguñava vizu-

elno projektovaçe i ureœivaçe, kao i neposredno pisaçe HTML koda. Dream-

weaver skrañuje vreme izrade Web prezentacija, a ima i alatke za çihovo 

meçaçe i odræavaçe.

U ovoj lekciji nauåiñete osnove Dreamweavera MX 

 

2004

 

 i upoznati kori-

sniåko okruæeçe, kao i alatke ovog programa. Formirañete lokalnu prezenta-

ciju za strane koje budete napravili i poåeñete da koristite glavne funkcije za 

odræavaçe prezentacije.

 

Formirajuñi 

prezentaciju 

na kojoj ñete 

raditi do kraja 

kçige, upo-

znañete se sa 

Dreamweave-

rovim radnim 

okruæeçem.
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Ova lekcija vas uåi kako da radite sa osnovnim parametrima dokumenta da 

biste napravili jednostavnu Web stranu, i kako da tu stranu testirate u raznim 

åitaåima Weba, ãto je neophodno za pravàeçe upotrebàivih Web lokacija.

Zavrãen primer iz ove lekcije nalazi se u poddirektorijumu Completed direkto-

rijuma Lesson_

 

01

 

_Basics na kompakt disku.

 

ÃTA ÑETE NAUÅITI 

 

U ovoj lekciji ñete:

 

•

 

upoznati okruæeçe Dreamweavera

 

•

 

formirati novu lokalnu Web prezentaciju

 

•

 

napraviti i snimiti nov dokument

 

•

 

upoznati alatke programa

 

•

 

dati naslov strani

 

•

 

zadati pozadinsku boju strane

 

•

 

zadati åitaåe Weba za proveru i testirati stranu.

 

POTREBNO VREME

 

Za savlaœivaçe ove lekcije trebañe vam, otprilike, jedan sat.

 

DATOTEKE LEKCIJE

 

Zavrãen projekat:

 

Lesson_01_Basics\Completed\introduction.htm
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RADNI PROSTOR

 

Da biste poåeli s radom u Dreamweaveru, morate se upoznati sa okruæeçem 

i poåetnim opcijama koje su dostupne u radnom prostoru.

 

O

 

TVORITE

 

 D

 

REAMWEAVER

 

 MX 

 

2004

 

.

 

U Windowsu:

 

 Dreamweaver MX 2004 nudi dve opcije radnog prostora za korisnike 

Windowsa: Designer i Coder. U ovoj veæbi, odaberite radni prostor Designer, jer 

ñete ga koristiti u celoj kçizi. Radni prostor Designer spaja sve prozore i panoe 

Dreamweavera u okruæeçe koje je optimizovano za vizuelnu izradu Web prezen-

tacije, a idealno je za dizajnere. Radni prostor Coder skrojen je za programere – one 

koji ñe uglavnom raditi sa HTML-om i drugim jezicima. Sve Dreamweaverove 

funkcije i alatke dostupne su u oba tipa radnog prostora. Kada prvi put pokrenete 

program u Windows okruæeçu, moæete odabrati jedan od çih.

 

Radni prostor moæete promeniti kasnije tako ãto ñete odabrati Edit > 
Preferences, izabrati kategoriju General i pritisnuti dugme Change Workspace. Ako pro-
menite parametre radnog prostora, Dreamweaver morate zatvoriti i ponovo pokrenuti da 
bi izmena bila aktivirana.

 

Na Macintoshu:

 

 Prethodno opisane opcije radnog prostora nisu dostupne na 

Macintosh raåunarima. Macintosh koristi sistem plutajuñih paleta koje moæete 

rasporediti kako æelite. Viãe o prilagoœavaçu Dreamweaverovog radnog prostora 

saznañete kasnije u ovoj lekciji i u ostatku kçige.

 

UVODNA STRANA

 

Ako ste sada prvi put otvorili Dreamweaver MX 2004, ugledañete uvodnu stranicu 

na kojoj se nalaze veze do nedavno otvaranih dokumenata, opcije za izradu novih 

dokumenta raznih tipova datoteka, primeri dizajna strane od kojih moæete poåeti 

izradu sopstvene prezentacije, dodatne informacije o programu, ukàuåujuñi vodiå 

n a p o m e n a

biraçe dreamweaverovog �
radnog prostora �
(samo za windows)
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kroz Dreamweaver i uputstva za rad u çemu, i veza do Web prezentacije Dream-

weaver Exchange koja sadræi resurse za proãirivaçe programa. Ako ne potvrdite 

poàe Don’t show again, uvodna strana ñe se pojavàivati svaki put kada otvorite 

Dreamweaver.

 

Ukoliko se uvodna strana nije otvorila kada ste pokrenuli program, 
a æelite da je pogledate, ili ako ne vidite poàe Don’t show again, prikazivaçe ove strane 
moæete zadati u okviru za dijalog Dreamweaver Preferences. Da biste to uradili, odabe-
rite Edit > Preferences (Windows), odnosno Dreamweaver > Preferences (Macintosh), 
sa liste Category odaberite General, pa potvrdite poàe Start Page u odeàku Document 
options. Kvaåica u ovom poàu znaåi da ñe se uvodna strana pojavàivati kada pokrenete 
program; ako kvaåice nema, uvodna strana se neñe otvarati. Morañete da otvorite i zatvo-
rite dokument, ili da zatvorite Dreamweaver pa ga ponovo pokrenete da bi izmena pos-
tala aktivna.

 

Kada poånete s izradom novih strana ili odaberete neku drugu opciju sa 

uvodne strane, ona ñe se sama zatvoriti. Korisnici Macintosha ovaj prozor mogu 

zatvoriti pritiskom na dugme u gorçem levom uglu prozora.

n a p o m e n a

grupe panoa

korisniåko okruæeçe dreamweavera mx 2004pano properties

uvodna stranatraka insert
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PRIPREMA ZA RAZVOJ PREZENTACIJE

 

Posvetite se pravàeçu detaàne skice ili dijagrama toka prezentacije, jer ñete tako 

lakãe razviti svoje zamisli, boàe shvatiti opseg projekta i uãtedeti vreme i resurse. 

Dobra Web prezentacija je intuitivna i ostavàa pozitivan i jedinstven utisak na 

posetioca. Izrada dobre Web prezentacije poåiçe definisaçem i saæetim prikazi-

vaçem razloga i potrebe za takvom Web lokacijom. Pre nego ãto poånete sa izra-

dom strana, postavite sledeña pitaça sebi ili naruåiocu prezentacije.

 

Ko åini vaãu publiku?

 

Poznavaçe posetilaca je suãtinski znaåajno. Definisaçem opãteg profila poseti-

laca lakãe ñete dopreti do ciàne grupe. Moæda ñete imati nekoliko vrsta korisnika; 

ako je tako, napravite profil za svaku od çih.

Kada shvatite ko saåiçava vaãu buduñu publiku, zapitajte se kakvom tehnolo-

gijom oni raspolaæu. Kakve softverske dodatke, åitaåe Weba i operativne sisteme 

koristi veñina buduñih posetilaca? Sve to morate uzeti u obzir da bi im Web loka-

cija bila dostupna. Primera radi, bilo bi pogreãno napraviti prezentaciju s elemen-

tima koje podræavaju samo najnoviji i najsavremeniji åitaåi, ako vaãa publika 

uglavnom koristi starije raåunare na kojima se takvi åitaåi ne mogu pokrenuti. 

 

Zaãto je Web prezentacija potrebna? Ãta posetioci treba da zapamte? 

 

Razmislite kakva ñe biti svrha prezentacije i kako ñe je svaki potencijalni poseti-

lac iskoristiti. Ãta je prezentaciji potrebno da bi posluæila svojoj svrsi? Iskoristite 

profile korisnika koje ste napravili da biste saåinili moguñi scenario za ono ãto ñe 

posetioci raditi na prezentaciji. Tada moæete odretiti tip sadræaja koji je potreban.

 

Kakav sadræaj vam treba za prezentaciju?

 

Vaæan deo priprema za projektovaçe i izradu Web prezentacije jeste definisaçe 

i prikupàaçe çenih sastavnih delova: teksta, slika i multimedijskih elemenata. 

Organizovaçem tih delova moñi ñete da napravite kompletnu i iscrpnu Web 

prezentaciju.

 

Kakvu poruku ñe prezentacija prenositi?

 

Morate znati ãta æelite da poruåite posetiocima. Ako sami ne znate ãta hoñete da 

kaæete, verovatno to neñe znati ni posetioci. Razjasnite poruku koju Web prezen-

tacija ãaàe. Komunikacija sa posetiocima je suãtinski deo odræavaça efikasne 

Web prezentacije, a ta veza delimiåno zavisi i od strukture prezentacije.

Web prezentacije se oslaçaju na strukturu i upravàaçe datotekama: loãe struk-

turirana Web lokacija zbuçuje posetioca dok se kreñe po çoj, a teãko se koristi i 

odræava. Da biste napravili jasnu lokaciju, koja je komunikativna i lako se koristi, 

morate do kraja da isplanirate strukturu i hijerarhiju datoteka i direktorijuma unu-

tar Web lokacije pre nego ãto poånete da pravite HTML dokumente.
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Izrada kompletne skice i detaànog dijagrama toka, ili scenarija, bitan je korak 

u procesu planiraça.

Kada je o ovoj kçizi reå, sve pripreme opisane u odeàku koji åitate, veñ su 

obavàene. Spremni ste da poånete s radom na projektu lokacije “Lights of the 

Coast” (Svetionici).

 

DEFINISAÇE LOKALNE WEB PREZENTACIJE

 

Prvi korak u pravàeçu Web prezentacije – koji bi trebalo da obavite pre nego ãto 

poånete izradu Web stranica – jeste da na svom raåunaru izaberete postojeñi 

direktorijum ili da napravite novi koji ñe sadræati celokupnu buduñu Web prezen-

taciju. Ovaj postupak se naziva “definisaçe lokalne Web prezentacije”. Izabrani 

direktorijum, 

 

lokalni korenski direktorijum

 

, definiãe granice lokalne Web prezenta-

cije na vaãem åvrstom disku i odraæava staçe udaàene Web lokacije, tj. stvarne 

lokacije na Web serveru kojoj ñe posetioci pristupati. Definisaçem lokalne Web 

prezentacije oåuvañete istu hijerarhiju direktorijuma u lokalnoj i udaàenoj verziji, 

ãto je neophodno prilikom izrade i odræavaça funkcionalne lokacije.

Pravàeçem lokalne Web prezentacije, koja se sastoji od lokalnog korenskog 

direktorijuma, unutar koga ñete izgraditi strukturu datoteka i direktorijuma buduñe 

lokacije, spreåiñete åuvaçe datoteka prezentacije van lokalnog korenskog direkto-

rijuma. Datoteke na åvrstom disku koje se nalaze izvan lokalnog korenskog direk-

torijuma ne mogu se preneti na udaàeni server. Zahvaàujuñi tom ograniåeçu, dok 

radite na prezentaciji neñete pristupati datotekama koje neñe biti dostupne kada 

prezentaciju objavite na Internetu. Da bi u potpunosti radile, mnoge Dreamwea-

verove funkcije (na primer, moguñnost aæuriraça svih veza do datoteke koja je pre-

meãtena u drugi direktorijum lokacije), zahtevaju da lokalna prezentacija bude 

definisana. Uvek bi trebalo da pravite lokalne Web prezentacije i da radite unutar 

çih. Ako to ne budete åinili, imañete problema s hipervezama, putaçama i kori-

ãñeçem datoteka. (Dreamweaverove alatke za ove funkcije objaãçene su u kasni-

jim lekcijama.)

Prezentaciju ñete razvijati unutar lokalne prezentacije na åvrstom disku, gde 

ñete napraviti i testirati Web strane.

 

Mada se preporuåuje, definisaçe lokalne prezentacije nije obavezno. 
Dreamweaver ñe vam omoguñiti da brzo meçate, povezujete i premeãtate datoteke i bez 
definisaça prezentacije. Viãe podataka o upravàaçu prezentacijom pronañi ñete u 
lekciji 12.

n a p o m e n a
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1)  

 

Kopirajte direktorijum DWMX

 

2004

 

_Project sa prateñeg kompakt diska na 

åvrsti disk.

 

Direktorijum DWMX2004_Project postañe osnovni (korenski) direktorijum vaãe 

lokalne prezentacije. Ovaj direktorijum sadræi sve datoteke i direktorijume za 

projekat “Lights of the Coast”, deo prezentacije koji ñete praviti zavrãavajuñi 

lekcije u ovoj kçizi. Kada otpoånete izradu drugih Web prezentacija, morañete 

i za çih da napravite osnovne direktorijume.

Ime osnovnog direktorijuma moæe da bude jednako imenu odgovarajuñe pre-

zentacije, ali i ne mora. Ako pravite mnogo prezentacija, koristite imena koja se 

lako razlikuju. Ime osnovnog direktorijuma sluæi samo vama, za rad s datotekama, 

poãto ga posetioci buduñe Web lokacije neñe videti.

 

Korenski direktorijum snimite na åvrsti disk izvan direktorijuma koji sadræi 
aplikaciju Dreamweaver. Ako to ne uradite, a budete morali ponovo da instalirate Dre-
amweaver, izgubiñete celokupan sadræaj çegovog direktorijuma i sve prezentacije koje su 
u çemu snimàene.

 

2)  

 

U Dreamweaveru izaberite Site › Manage Sites. Pritisnite dugme New, pa iz 

padajuñeg menija odaberite Site.

 

Otvoriñe se okvir za dijalog Site Definition s dve kartice: Basic i Advanced. Te 

kartice vam omoguñavaju da izaberete postupak definisaça prezentacije. Kartica 

Basic, koja se podrazumevano prikazuje kada otvorite okvir za dijalog, vodi vas 

kroz postupak korak po korak. Kartica Advanced daje joã nekoliko dodatnih opcija 

i parametara za podeãavaçe, ali ne sadræi tekstualna objaãçeça koja se prikazuju 

u reæimu Basic. 

 

Novu prezentaciju moæete otvoriti i direktno na uvodnoj strani tako ãto ñete u 
odeàku Create New odabrati opciju Dreamweaver Site. Pojaviñe se okvir za dijalog Site 
Definition (koji smo veñ opisali).

s a v e t 1

s a v e t 1
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U ovoj veæbi odaberite karticu Basic ako nije veñ izabrana.

 

Ako dosad niste napravili nijednu prezentaciju u Dreamweaveru, 
pano Files prikazuje hijerarhiju direktorijuma na vaãem raåunaru i hipervezu Define 
a Site kojom otvarate okvir za dijalog Site Definition. U padajuñem meniju panoa Site 
na Macintoshu podrazumevano je izabran Computer, koji na poåetku sadræi Macintosh 
HD, FTP & RDS Servers i Desktop Items. U Windowsu je podrazumevano izabran 
Desktop, koji na poåetku sadræi My Computer, Network Neighborhood, FTP & RDS 
Servers i Desktop Items. Kada napravite prezentaciju, ona ñe postati podrazumevano 
izabrana. Ako radite na viãe prezentacija, Dreamweaver ñe na panou Files prikazivati 
onu na kojoj ste posledçi put radili. Pano Files se nalazi u istoimenoj grupi panoa.

Zbog greãke u verziji Dreamweavera MX 2004 za Macintosh, grupa panoa Files 
moæda se zove Assets. Podrazumevano ime te grupe je Files, ali kada je proãirite (ãto ñete 
nauåiti u lekciji 12), ona dobija ime Assets. Podrazumevano ime ñete joj vratiti tako ãto 
ñete je preimenovati, ili obrisati datoteku Dreamweaver MX 2004 Preferences. Meçaçe 
imena grupe panoa neñe uticati na ostale funkcije programa. Da biste je preimenovali, 
pritisnite kontekstni meni u gorçem desnom uglu grupe panoa Files (ili Assets), pa odabe-
rite stavku Rename Panel Group. U poàe unesite 

 

Files

 

 i pritisnite OK. Da biste obrisali 
datoteku Dreamweaver MX 2004 Preferences, izaœite iz Dreamweavera, pronaœite direk-
torijum Macintosh > Users > vaãe korisniåko ime > Library > Preferences, obriãite dato-
teku Dreamweaver MX 2004 Prefs i ispraznite direktorijum Trash (tj. korpu za otpatke). 
Kada ponovo pokrenete Dreamweaver, grupa panoa ñe imati ime Files. Imajte na umu 
da, ako obriãete datoteku Dreamweaver MX 2004 Preferences, drugi parametri ili alatke 
koje ste meçali biñe vrañeni u podrazumevano staçe. Nijedno od ova dva reãeça neñe 
trajno promeniti ime grupe panoa – ono ñe opet biti Assets kada proãirite pano Files.

 

3)  

 

Na kartici Basic okvira za dijalog Site Definition, Dreamweaver postavàa 

pitaçe: “What would you like to name your site?” (Kako ñete nazvati prezenta-

ciju?). Upiãite 

 

Lights of the Coast

 

 

 

u poàe Name i pritisnite Next. 

kartica basic �
okvira za dijalog �
site definition

n a p o m e n a
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Lights of the Coast je ime prezentacije koju pravite u ovoj lekciji. Kada sami 

budete pravili prezentacije, imenovañete ih proizvoàno. Jasna i specifiåna imena 

omoguñavaju da razlikujete prezentacije veñ po imenu, ãto olakãava rad s viãe 

prezentacija. Ovo ime prezentacije sluæi samo vama, jer ga posetioci lokacije neñe 

videti.

 

Na kartici Advanced, ime prezentacije se upisuje u poàe Site name 
u kategoriji Local Info. Tokom definisça prezentacije moæete prelaziti sa kartice Basic na 
karticu Advanced ako hoñete da vidite kako ona izgleda. Sa karticom Advanced radiñete u 
lekciji 12.

 

4)  

 

Dreamweaver pita: “Do you want to work with a server technology such as 

ColdFusion, ASP.NET, ASP, JSP or PHP?” (Æelite li da koristite serverske tehnolo-

gije ColdFusion, ASP.NET, ASP, JSP ili PHP?) Pritisnite radio-dugme “No, I do not 

want to use a server technology.” Pritisnite Next da biste preãli u sledeñi odeàak.

 

Poãto u ovoj kçizi pravite stranice iskàuåivo za statiåke prezentacije (koje ne 

sadræe baze podataka i druge serverske tehnologije), izaberite odriånu opciju. 

Ako kasnije poæelite da izmenite definiciju prezentacije, odaberite Site > Manage 

Sites, izaberite prezentaciju sa liste, pa pritisnite dugme Edit.

n a p o m e n a

navoœeçe serverske tehnologije u okviru za dijalog site definition
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Ovaj deo kartice Basic odgovara kategoriji Testing Server na kartici 
Advanced, gde imate i dodatne moguñnosti za pravàeçe dinamiåkih prezentacija, kao ãto 
je biraçe modela servera koji ñe se koristiti na udaàenom serveru. 

 

5)  

 

Na vrhu ovog podruåja Dreamweaver pita: “How do you want to work with your 

files during development?” (Izaberite naåin rada s datotekama tokom razvoja ove 

prezentacije.) Pritisnite radio-dugme “Edit local copies on my machine, then 

upload to server when ready (recommended).” 

 

U ovoj kçizi radiñete samo s datotekama na svom raåunaru. Neñete morati da 

pristupate Web serveru.

 

6)  

 

U istom podruåju, Dreamweaver pita: “Where on your computer do you want to 

store your files?” (Gde ñete smestiti datoteke ove prezentacije?). Pritisnite sliåicu 

omotnice desno od poàa za tekst i pronaœite direktorijum DWMX

 

2004

 

_Project. 

 

Ovo poàe za tekst omoguñava da zadate direktorijum na svom disku u kom se 

åuvaju sve datoteke za prezentaciju. Taj direktorijum je jednak korenskom direk-

torijumu na udaàenoj prezentaciji. Dreamweaver koristi lokalni korenski direk-

torijum da bi odredio putaçe do dokumenata, slika i hiperveza u prezentaciji. 

O putaçama i hipervezama åitañete u lekciji 4.

n a p o m e n a

odaberite naåin rada s datotekama
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Direktorijum DWMX2004_Project kopirali ste s prateñeg kompakt diska na 

åvrsti disk u koraku 1.

 

U Windowsu:

 

 izaberite direktorijum DWMX2004_Project i pritisnite dugme 

Open. Zatim pritisnite dugme Select da biste izabrali direktorijum DWMX2004 

_Project kao svoj korenski direktorijum. U doçem levom uglu okvira za dijalog 

Choose local root folder for site Lights of the Coast pojaviñe se tekst “Select: 

DWMX2004_Project”.

 

Na Macintoshu:

 

 izaberite direktorijum DWMX2004_Project i pritisnite dugme 

Choose. 

Putaça do korenskog direktorijuma, DWMX2004_Project, prikazuje se u 

poàu za tekst i relativna je, tj. odnosi se na vaã disk.

Ovo poàe za tekst podrazumevano sadræi putaçu do direktorijuma Lights of 

the Coast. Ako biste koristili ovu podrazumevanu vrednost, napravili biste na 

svom åvrstom disku nov direktorijum, nazvan Lights of the Coast, koji bi postao 

lokalni korenski direktorijum. Na Windows raåunaru, taj direktorijum bi bio 

smeãten u direktorijum My Documents na disku C. Na Macintoshu on obiåno 

postaje poddirektorijum direktorijuma Users/vaãe korisniåko ime/Sites. Svaki put 

zadavaçe korenskog direktorijuma u okviru za dijalog site definition
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kada odaberete novo mesto za åuvaçe lokalnog korenskog direktorijuma, ono 

postaje podrazumevano i pojavàuje se u tekstualnom poàu kada definiãete sle-

deñe prezentacije. Meœutim, u ovom sluåaju, za lokalni korenski direktorijum 

treba da odaberete direktorijum DWMX2004_Project (koji sadræi viãe datoteka 

potrebnih za rad po lekcijama ove kçige).

Kada budete pravili druge prezentacije, a niste sami prethodno napravili 

potreban direktorijum, moæete pustiti Dreamweaver da automatski napravi 

korenski direktorijum na osnovu imena prezentacije koje ste zadali.

 

7)  

 

Pritisnite Next da biste preãli na sledeñi korak. Izaberite “None” u padajuñoj 

listi ispod pitaça “How do you connect to your remote server?” (Kako se pove-

zujete s udaàenim serverom?).

 

U ovoj kçizi radite iskàuåivo na lokalnoj prezentaciji. Neñete morati da pristu-

pate udaàenom Web serveru. Viãe informacija o povezivaçu s udaàenim serve-

rom pronañi ñete u lekciji 12.

 

KARTICA ADVANCED

 

Prethodno objaãçeni odeàak kartice Basic odgovara tekstualnom poàu 

Local root folder u kategoriji Local Info na kartici Advanced. Kartica 

Advanced omoguñava i da odaberete opcije Refresh local file list automa-

tically, Enable cache, Default images folder i HTTP address.

Opcija Refresh local file list automatically podrazumevano je potvrœena, 

i omoguñava da Dreamweaver automatski aæurira listu datoteka u prezen-

taciji, svaki put kada dodate novu datoteku. Ako iskàuåite ovu opciju, sami 

ñete morati da aæurirate lokalne datoteke svaki put kada napravite izmenu, 

na primer, dodate ili obriãete datoteku.

Opcija Enable cache takoœe je podrazumevano potvrœena. Ona odvaja 

deo memorije (keã memoriju) za åuvaçe åesto koriãñenih podataka pre-

zentacije, åime se poveñava brzina povezivaça i obavàaça zadataka veza-

nih za upravàaçe prezentacijom. Mada ñete ovu opciju obiåno ostaviti 

izabranu, imajte na umu da ponovno odvajaçe keã memorije moæe uspo-

riti izvrãavaçe operacija u veoma velikim prezentacijama.

Opcija definisaça podrazumevanog direktorijuma za slike (Default 

images folder) nije obavezna, a omoguñava zadavaçe lokacije slika u pre-

zentaciji. O slikama u prezentaciji govori lekcija 3.

Joã jedna opciona funkcija jeste HTTP address koja se koristi za defi-

nisaçe URL adrese Web prezentacije. Ta adresa sluæi za proveru apsolut-

nih hiperveza. Viãe informacija o hipervezama pronañi ñete u lekciji 4.



 

20

 

LEKCIJA  

 

1

 

DW04

 

, May 6, 2004 9:43 am

 

 Ovom podruåju kartice Basic odgovara kategorija Remote Info na kar-
tici Advanced, gde ima dodatnih opcija za definisaçe prenosa datoteka na udaàeni server.

 

8)  

 

Pritisnite Next da biste preãli na sledeñi korak. Pregledajte podatke o prezen-

taciji koje ste dosad zadali, pa pritisnite dugme Done na dnu okvira za dijalog. 

opcije za povezivaçe �
u okviru za dijalog �
site definition

n a p o m e n a

saæetak podataka o prezentaciji u okviru za dijalog site definition



 

OSNOVE DREAMWEAVERA MX 2004

 

21

 

DW04

 

, May 6, 2004 9:43 am

 

Poãto ste u odeàcima Remote Info i Testing Server izabrali opcije No, Dream-

weaver ñe kao vrednost obe opcije prikazati tekst “Access: I’ll set this up later.”

Kada pritisnete dugme Done, Dreamweaver ñe pregledati datoteke u direk-

torijumu DWMX2004_Project da bi napravio keã memoriju za prezentaciju. Na 

kratko ñete videti okvir za dijalog dok Dreamweaver ne zavrãi proces. Moæete 

pritisnuti dugme Done da biste zatvorili okvir za dijalog Manage Sites.

Pano Files sada prikazuje direktorijum DWMX2004_Project. O panou Files 

viãe ñete nauåiti u lekciji 12.

 

PRAVÀEÇE I SNIMAÇE NOVE STRANE 

 

Kada definiãete lokalnu prezentaciju, moæete poåeti sa izradom Web strana. 

Svaki put kada napravite novu stranu, prvo treba da snimite dokument.

 

1)  

 

Izaberite File › New. Pritisnite karticu General okvira za dijalog New Docu-

ment i izaberite opciju Basic Page u spisku kategorija. U padajuñoj listi Basic 

Page izaberite opciju HTML i pritisnite dugme Create.

 

Za otvaraçe okvira za dijalog New Document moæete da upotrebite i preåice 
s tastature, Ctrl+N (Windows), odnosno Command+N (Macintosh). Ako hoñete da preåi-
com sa tastature otvorite nov dokument odmah, bez otvaraça okvira za dijalog New Doc-
ument, odaberite Edit > Preferences; sa liste Category odaberite New Document i iskàuåite 
opciju Show New Document Dialog on Command+N (Macintosh), odnosno opciju Show 
New Document Dialog on Ctrl+N (Windows). Ovaj odeàak nudi i opcije za meçaçe 
podrazumevanog tipa dokumenta, oznake tipa i naåina kodiraça. U lekcijama pretposta-
vàamo da koristite podrazumevane vrednosti. Okvir za dijalog Preferences otvoriñete i ako 
pritisnete dugme Preferences na dnu okvira za dijalog New Document.

 

Otvoriñe se okvir za dijalog New Document sa dve kartice: General i Templa-

tes. U ovoj veæbi ñete napraviti novu HTML (Hypertext Markup Language) 

s a v e t 1
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stranu. Opcija za izradu nove HTML strane nalazi se u kategoriji Basic kartice 

General. Ona je podrazumevana, pa je verovatno veñ izabrana.

Pored HTML strana, u okviru za dijalog New Document postoje opcije i za 

razne druge vrste strana: CSS, JavaScript i XML, kao i za dinamiåke strane koje 

koriste jezike poput ASP-a, ColdFusiona i PHP-a. U spisku kategorija u levoj 

koloni okvira za dijalog ponuœene su opcije specifiånih tipova strana: Templates 

(ãabloni), CSS Style Sheets (kaskadni opisi stilova), Framesets (skupovi okvira) 

i Page Designs (gotovi modeli HTML strana). Zasad neñete praviti takve strane, 

ali treba da znate da postoje. Sadræaj sredçe kolone okvira za dijalog meça se 

u zavisnosti od kategorije koja je izabrana u levoj koloni.

 

Na dnu okvira za dijalog New Document nalazi se opcija Make docu-
ment XHTML compliant (neka dokument bude kompatibilan sa jezikom XHTML). 
HTML je ograniåen, naroåito po tome ãto nove moguñnosti nisu kompatibilne s çegovim 
starijim verzijama, a postoji i mnogo problema s izvrãavaçem u razliåitim åitaåima 
Weba. XHTML (Extensible Hypertext Markup Language) proãiruje moguñnosti HTML-a, 
pretvarajuñi ga u jezik tipa XML (Extensible Markup Language). Prednosti koriãñeça 
XHTML-a obuhvataju kompatibilnost sa starijim i novijim verzijama, izvrãavaçe na 
razliåitim ureœajima za pristupaçe Webu – kao ãto su mobilni telefoni i ruåni raåunari, 
i moguñnost proãireça. Za veæbe u ovoj kçizi, pomenutu opciju moæete da ostavite 
nepotvrœenu. 

okvir za dijalog new document

n a p o m e n a
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Kada pritisnete dugme Create, pojaviñe se nov nenaslovàen HTML doku-

ment, a uvodna strana ñe se automatski zatvoriti.

 

Nov dokument moæete napraviti i direktno sa uvodne strane tako ãto ñete iz 
kolone Create New odabrati tip datoteke (kao ãto je HTML koji ste odabrali u ovoj veæbi). 
Pojaviñe se nov dokument izabranog tipa, a zatvoriñe se uvodna strana.

 

2)  

 

Izaberite opciju menija File › Save i pronaœite direktorijum Lesson_

 

01

 

_Basics, 

gde ñete snimiti ovu datoteku. Upiãite 

 

introduction.htm

 

 

 

u poàe File Name na dnu 

okvira za dijalog Save As, pa pritisnite dugme Save.

 

Ne åekajte da na Web stranu stavite tekst ili slike, snimite je åim otvorite nov 

dokument. Ukoliko najpre snimite datoteku, sve putaçe koje referenciraju slike, 

kao i ostale elemente koje budete uvozili, biñe propisno formirane. Ukoliko ne sni-

mite datoteku, za opis lokacije elementa koji se uvozi koristiñe se relativna putaça 

koja poåiçe sa file:// i odnosi se na åvrsti disk. Ako pokuãate da umetnete objekat 

na stranu, a da prethodno niste snimili dokument, Dreamweaver vas upozorava da 

za taj element mora upotrebiti ime putaçe u obliku file://. Takve putaçe ne funk-

cioniãu na udaàenim serverima jer opisuju lokaciju datoteka na vaãem raåunaru.

 

Za snimaçe dokumenta moæete da upotrebite preåice s tastature Ctrl+S 
(Windows), odnosno Command+S (Macintosh). Ako budete åesto snimali dokument, neñete 
izgubiti mnogo uloæenog rada kada se, iz bilo kog razloga, sruãi aplikacija ili operativni 
sistem raåunara.

 

Moæete da koristite nastavak imena (oznaku tipa) datoteka .html ili .htm. 

Kada snimite dokument, Dreamweaver mu automatski dodaje nastavak imena 

.htm ukoliko sami ne navedete nastavak. Podrazumevani nastavak imena moæete 

da vidite kada izaberete Edit > Preferences (Windows), odnosno Dreamweaver > 

Preferences (Macintosh) i kategoriju New Document. Podrazumevani nastavak 

prikazan je u tekstualnom poàu, mada je nedostupan (sive boje). Moæete ga 

promeniti u XML datoteci. Nastavke .htm i .html moæete koristiti i u Windowsu 

i na Macintoshu za isti tip dokumenta, ali to ne znaåi da raåunar ne pravi razliku 

izmeœu çih – uvod.html nije isto ãto i uvod.htm. Oba nastavka imena predsta-

vàaju istu vrstu datoteke, ali na istom serveru (i u istom direktorijumu) moæete da 

åuvate i uvod.html i uvod.htm, jer te datoteke imaju razliåita imena. Obiåno je 

lakãe dræati se jednog ili drugog da biste izbegli greãke prilikom pravàeça hiper-

veza. Hiperveza s datotekom uvod.html ne povezuje posetioca s datotekom 

uvod.htm. Hiperveze i putaçe su detaànije obraœene u lekciji 4.

 

U Windowsu, ako je sistem podeãen tako da automatski dodaje odgovarajuñi 
nastavak imena, korisnici ne moraju da upisuju .htm u poàe File Name. Nastavak .htm 
se na Macintoshu pojavàuje u okviru za dijalog Save As.

s a v e t 1

s a v e t 1

s a v e t 1
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U primerima i materijalu obuhvañenom na kompakt disku, kao i u celoj kçizi, 

koristi se nastavak imena .htm. 

Davaçe imena datotekama koje ñe se koristiti na Web serveru razlikuje se od 

imenovaça datoteka za koriãñeçe sa lokalnog åvrstog diska. Morate da saznate 

koji se operativni sistem koristi na serveru – najåeãñi su Unix, Linux, Windows 

NT/2003 i Mac OS. Struktura imena se razlikuje na svakoj od ovih platformi. Pri-

mera radi, Unix razlikuje mala i velika slova u imenima datoteka, pa u çemu 

moja_datoteka.htm nije isto ãto i MOJA_DATOTEKA.HTM. Koriãñeçe iskàu-

åivo malih slova pojednostavàuje imenovaçe datoteka i olakãava odræavaçe ujed-

naåenosti. Za imena datoteka upotrebàavajte samo slova (A–Z) i brojke (0–9). Evo 

joã nekih vaænih konvencija za imenovaçe datoteka i direktorijuma:

 

•

 

U imenima datoteka ne sme biti razmaka (belina). Ako treba razdvojiti reåi, 

upotrebite potcrtu ili crticu. Razmaci izazivaju probleme zato ãto ih åitaåi 

Weba zameçuju oznakom %20.

 

•

 

Ne smete koristiti specijalne znakove kao ãto su %, *, > ili /. Nemojte kori-

stiti taåke ni zareze.

 

•

 

Ne poåiçite imena datoteka brojkom.

 

•

 

Koristite ãto kraña imena datoteka i direktorijuma. Ne zaboravite da ime 

direktorijuma postaje sastavni deo URL adrese koju morate otkucati da 

biste doãli do strane.

Novi dokumenti dobijaju podrazumevnao ime Untitled-1, a brojevi rastu za 

svaki novi dokument koji napravite.

 

Opcije New Document i Save dostupne su i na paleti Standard koju ñete otvo-
riti ako odaberete View > Toolbars > Standard. Palete alatki koje otvorite, osim podra-
zumevane palete Document, biñe prikazane na mestu na koje ste ih pomerili samo u 
aktivnom dokumentu; izmene se ne prenose na druge dokumente.

okvir za dijalog save as

s a v e t 1
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ALATKE

 

Pre nego ãto preœete na izradu Web strana, treba da se upoznate sa raznim alat-

kama i panoima u Dreamweaveru MX 2004 koji omoguñavaju da efikasno radite.

 

1)  

 

Postavite pokazivaå iznad prozora dokumenta i palete Document. Zadræite ga 

iznad dugmeta da biste videli çegovo ime.

 

Prilikom dizajniraça i kodiraça, najveñi deo posla obavàañete u prozoru doku-

menta. To podruåje je poznato i kao “telo” strane (engl. 

 

body

 

). Tu moæete umetati, 

meçati i brisati razne vrste elemenata koji åine Web stranu. Dok radite, strana je 

u prozoru dokumenta prikazana otprilike onako kako ñe izgledati u åitaåu Weba.

Ime datoteke introduction.htm (pod kojim ste stranu snimili u prethodnoj 

veæbi) prikazano je na naslovnoj traci u zagradama, nakon imena direktorijuma 

u kojem se nalazi. Ova strana se podrazumevano zove Untitled Document. 

Naslov dokumenta je prikazan i u poàu Title na paleti Document. Paleta Docu-

ment – koju moæete prikazati i sakriti preko menija View > Toolbars – sadræi dug-

mad i menije pomoñu kojih brzo pristupate najåeãñim operacijama. Ona je deo 

prozora dokumenta. Korisnici Windowsa mogu dvaput pritisnuti ili povuñi 

hvataàku na levoj ivici palete da bi je odvojili od prozora dokumenta, pa ñe ova 

paleta postati zaseban pano.

U Dreamweaveru postoje tri naåina prikaza: prikaz Design (izgled strane), pri-

kaz Code (kôd) i prikaz Split (i izgled i kôd). Dugmad za ukàuåivaçe ovih pri-

kaza nalazi se na levoj strani palete Document. Imena reæima prikaza videñete 

ako pokazivaå miãa zadræite na dugmadima. Trenutno bi trebalo da posmatrate 

prikaz Design. Dugme aktivnog reæima biñe istaknuto. Sa prikazima Code i Split 

radiñete u lekciji 14. Ako je prozor podeàen na dva okna od kojih se u jednom 

nalazi kôd, ili ako vidite samo jedno okno sa kodom, odaberite ikonicu Design 

View sa palete Document.

U doçem levom uglu prozora dokumenta nalazi se Tag Selector – biraå 

HTML oznaka. Tag Selector uvek poåiçe od oznake 

 

<body>

 

, hijerarhijski prika-

zujuñi HTML oznake koje vaæe u trenutno izabranom elementu. Poãto koristi 

HTML oznake koje odgovaraju elementima, Tag Selector omoguñava da se brzo 

kreñete kroz hijerarhiju koda da biste videli na kom elementu radite i lako iza-

brali druge elemente. Navikavaçe na rad s Tag Selectorom naroåito ñe se isplatiti 

u lekciji 5, kada za izradu strana poånete da koristite tabele.

 

Ukoliko ne vidite Tag Selector, smaçite dokument. Tag Selector je moæda 
skriven ispod panoa Properties.

s a v e t 1
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Tokom rada na lekcijama u ovoj kçizi upoznañete se s raznim dugmadima 

i prilagodàivim opcijama u prozoru dokumenta.

 

2)  

 

Postavite pokazivaå na traku Insert. Zaustavite ga iznad dugmeta da biste 

videli çegovo ime.

Traka Insert sadræi viãe objekata ili elemenata koje moæete da postavite na stranu: 

slike, tabele, specijalne znakove, obrasce i HTML kôd. Elementi su razvrstani u 

osam grupa u zavisnosti od vrste: Common (uobiåajeni elementi), Layout (raspo-

red elemenata), Forms (obrasci), Text, HTML, Application, Flash Elements i 

Favorites (omiàeni elementi). Ime aktivne grupe prikazano je u meniju. Grupa 

Common je podrazumevano aktivna. Na drugu grupu objekata prebacivañete se 

preko menija. Mnogi pojedinaåni objekti iz ovih grupa imaju sopstvene menije 

koji su oznaåeni malom crnom strelicom (trougliñem), a u çima se nalaze dodatne 

alatke, opcije i drugi srodni objekti. Pritisnite ikonicu objekta i trougliñ da biste 

otvorili meni. Posledça opcija u meniju trake Insert jeste Show as Tabs kojom 

ñete traku Insert prikazati sa odgovarajuñim jeziåkom za svaku grupu elemenata. 

prikaz design

biraå html oznaka prozor dokumenta

naslovna traka dokumenta meni s opcijama za prikaz

paleta�
document

hiperveza datum

komentar ãablonimeni (aktivna grupa �
opcija je common)

biraå html oznaka
veza do e-poãte multimedija

imenovano sidriãte znak da postoje i dodatne alatke
tabela slika
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Da biste traku Insert vratili u format menija, odaberite opciju Show as menu iz 

kontekstnog menija u gorçem desnom uglu. Odaberite prikaz koji vam se dopada.

U ovoj kçizi se naizmeniåno koriste termini “objekat” i “element”. 
Gde god je bilo moguñe, “objekat” se koristi za oznaåavaçe dugmeta, a “element” za 
objekat koji je postavàen u prozor dokumenta.

Da biste ubacili element, prevucite çegovu ikonicu s trake Insert na odgo-

varajuñe mesto u prozoru dokumenta. Drugi naåin je da kursor postavite u doku-

ment na mesto gde bi element trebalo da se nalazi, a potom da pritisnete ikonicu 

objekta. Kada pritisnete ikonicu, element ñe se pojaviti na mestu gde ste postavili 

kursor.

3)  Postavite pokazivaå miãa iznad panoa Properties. Zadræite ga iznad dugmeta 

da biste videli çegovo ime.

Pano Properties koristiñete za pregledaçe i meçaçe atributa (svojstava) izabra-

nog teksta, slike, tabele i drugih elemenata na strani. To je kontekstni pano – atri-

buti se meçaju u zavisnosti od onoga ãto je izabrano u prozoru dokumenta. Da 

biste proãirili ili saæeli pano Properties, pritisnite strelicu u doçem desnom uglu 

panoa. Kada je pano saæet, neka svojstva neñe biti vidàiva sve dok ga ne proãirite. 

Korisnici Windowsa mogu da smaçe pano tako da se vidi samo çegovo ime da bi 

dobili veñi prostor za prikaz.

Korisnici Windowsa mogu promeniti veliåinu prostora za pano Properties (i 
ostalih panoa koji se nalaze u tom podruåju) tako ãto ñe povuñi dugme sa strelicom na hor-
izontalnoj ivici. Kada pritisnete dugme sa strelicom, celo podruåje ñe se saæeti; da biste ga 
ponovo otvorili, ponovo pritisnite isto dugme. Horizontalna ivica nije deo okruæeça na 
Macintoshu.

traka insert sa jeziåcima kontekstni meni

n a p o m e n a

pano properties strelica za proãirivaçe/saæimaçe panoa

s a v e t 1
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RAD S PANOIMA
Najveñi deo Dreamweaverovih panoa usidren je (u vidu prozora s jeziåcima) u grupi 

panoa u zavisnosti od çihove funkcije. Podrazumevane grupe panoa su Design, 

Code, Application, Tag Inspector i Files. Panoima moæete pristupati preko tih 

grupa ili preko menija Window. Grupe panoa omoguñavaju da brzo pristupate 

panoima koje najåeãñe koristite, ili da ih sakrijete. Kada su panoi usidreni, imañete 

viãe prostora na ekranu, a u isto vreme, lako ñete moñi da pristupite panoima koji 

vam trebaju. Svaka grupa panoa moæe biti proãirena tako da se vide svi panoi, ili 

saæeta tako da prikazuje samo ime grupe.

Ako ste ranije otvarali Dreamweaver, panoi ñe biti postavàeni upravo onako 

kako su bili razmeãteni kada ste posledçi put zatvorili program. U meniju Win-

dow, kvaåica pored stavke znaåi da je pano ili paleta alatki izabrana i aktivna 

(vidàiva) u grupama panoa.

Veñ smo objasnili da zbog greãke u verziji programa za Macintosh, 
pano Files na ovoj platformi dobija ime Assets kada se proãiri (o çemu govorimo u lekciji 
12). Detaài o tome nalaze se u veæbi Definisaçe lokalne Web prezentacije u ovoj lekciji.

1)  Strelicu na grupi panoa Design pritisnite jednom da biste saæeli grupu, a 

dvaput da biste je proãirili.

Grupa panoa Design nalazi se na vrhu grupa panoa. Kada je proãirite videñete 

pano CSS Styles s kojim ñete raditi u lekciji 6. U gorçem desnom uglu panoa 

nalazi se kontekstni meni koji nije vidàiv kada je grupa saæeta.

U meniju Window sakriveni pano nema kvaåicu pored imena. Da biste prika-

zali sakriveni pano, odaberite ga u pomenutom meniju. Ako se pano koji ste oda-

brali nalazi u grupi koja trenutno nije dostupna, pojaviñe se i pano i grupa panoa. 

Ukoliko je grupa u kojoj se nalazi æeàeni pano vidàiva, ali saæeta, a vi iz menija 

Window odaberete pano, grupa ñe se proãiriti i prikazañe se odabrani pano.

n a p o m e n a

kontekstni meni

pano css styles

strelica za proãirivaçe/saæimaçe
hvataàka
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Moæe se desiti da pano bude sakriven ispod drugog panoa ili prozora doku-
menta. Taj problem moæe nastati prilikom promene rezolucije ekrana. Ako je pano nestao 
i ne moæete ga prikazati tako ãto ñete ga odabrati u meniju Window, moæda ñete morati da 
odaberete Window > Arrange Panels da biste sve otvorene panoe vratili na çihovo 
podrazumevano mesto. Traka Insert ñe se vratiti u gorçi levi ugao ekrana, pano Proper-
ties na dno, a svi ostali otvoreni panoi na desnu stranu ekrana.

2)  Zadræite pokazivaå miãa na dnu panoa CSS Styles, na liniji koja taj pano raz-

dvaja od grupe panoa Code. Kada pokazivaå dobije oblik vertikalne dvosmerne 

strelice, pritisnite i povucite naviãe da biste smaçili veliåinu panoa CSS Styles.

Dok radite moæda ñete morati da meçate veliåinu panoa da biste prikazali viãe 

informacija ili napravili viãe mesta za ostale panoe i prozor dokumenta.

Korisnici Windowsa mogu da promene i ãirinu podruåja za sve usidrene 
grupe panoa tako ãto ñe povuñi dugme sa strelicom na veritkalnoj ivici. Kada pritisnete 
dugme sa strelicom, saæeñe se celo podruåje za usidrene grupe. Ponovo pritisnite isto dugme 
da biste otvorili podruåje usidrenih grupa panoa. Vertikalna ivica nije deo okruæeça na 
Macintoshu.

s a v e t 1
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Kada se upoznate sa Dreamweaverovim panoima i alatkama, moæete prilago-

diti okruæeçe razmeãtajuñi grupe panoa tako da odgovaraju vaãem naåinu rada.

Sve grupe panoa moæete odvojiti od podruåja u kom su usidrene. Da 
biste odvojili grupu panoa, postavite pokazivaå na hvataàku na levoj strani grupe, ozna-
åenu taåkicama. Kada pokazivaå dobije oblik krstiña sa strelicama (Windows), odnosno 
ãake (Macintosh), pritisnite i povucite grupu panoa da biste je odvojili, pa pustite taster 
miãa. Dok povlaåite grupu panoa, videñete çegovu bledu sliku. Ovaj novi prozor ili 
grupu panoa moæete preimenovati tako ãto ñete pritisnuti ikonicu kontekstnog menija i 
odabrati stavku Rename Panel Group. Dok vrañate grupu panoa u podruåje za usidra-
vaçe, videñete çenu bledu sliku pre nego ãto je pustite, i debelu crnu liniju na mestu gde ñe 
se grupa panoa pojaviti. Grupe panoa moæete i prerasporediti koristeñi hvataàku da biste 
pomerili bilo koju grupu iznad ili ispod ostalih grupa. Ako hoñete da promenite organiza-
ciju panoa tako ãto ñete ih premestiti u druge grupe, pritisnite jeziåak panoa da biste ga 
odabrali, pa iz kontekstnog menija odaberite stavku Group Components With.

U lekcijama pretpostavàamo da koristite podrazumevanu konfiguraciju panoa 

u Dreamweaveru MX 2004, bez izmeçenih imena ili redosleda panoa i grupa 

panoa.

Korisnici Windowsa: Za prikazivaçe prozora dokumenata postoje tri opcije: 

Cascade, Tile Horizontally i Tile Vertically. Ako je otvoreno viãe prozora doku-

menata, opcija Cascade ñe ih prikazati kao plutajuñe prozore, postavàene jedan 

preko drugog u delu radnog prostora nameçenom za prozor dokumenta. Opcija 

Tile Horizontally poreœañe prozore dokumenata horizontalno. Opcija Tile Verti-

cally postaviñe prozore dokumenata vertikalno, jedan uz drugi. Ove opcije se 

nalaze u meniju Window.

Korisnici Macintosha: Opcije radnog prostora koje su prethodno opisane ne 

postoje na Macintoshu.

DAJTE NASLOV WEB STRANI
Svaki HTML dokument mora imati naslov, koji sluæi prvenstveno za çegovu 

identifikaciju. On se prikazuje na naslovnoj traci åitaåa, ukazuje na sadræaj strane 

i automatski postaje ime obeleæivaåa (engl. bookmark) u listama Favorites. Birajte 

kratke, informativne izraze koji poåiçu imenom prezentacije i opisuju namenu 

dokumenta. Neka vam preœe u naviku da svakoj strani date naslov pre nego ãto 

poånete da joj dodajete tekst i slike. Ako zaboravite na to, Dreamweaver ñe strani 

dati podrazumevano ime Untitled Document.

n a p o m e n a
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Upiãite Lights of the Coast u poàe Title na paleti Document. Pritisnite Enter (Win-

dows), odnosno Return (Macintosh), ili pritisnite unutar dokumenta introduc-

tion.htm.

Ako ne vidite paletu Document na kojoj je poàe Title, izaberite opciju menija 
View > Toolbars > Document.

Poàe Title na poåetku prikazuje naslov Untitled Document, pa ñete sada 

zameniti taj naslov pravim naslovom uvodne strane prezentacije.

Dreamweaver ñe vas nekoliko puta upozoriti ako zaboravite da date naslov 

strani. Pogledajte naslovnu traku dokumenta na kojoj se prikazuje çegov naslov 

i ime datoteke. Ako ugledate naslov “Untitled Document (ime_direktorijuma/

ime_datoteke.htm)”, niste dali naslov tom dokumentu. “Untitled Document” se 

prikazuje i u poàu Title na paleti Document.

Naslov dokumenta moæete navesti i u tekstualnom poàu kategorije 
General okvira za dijalog Page Properties. Da biste otvorili taj okvir za dijalog, odabe-
rite Modify > Page Properties.

ZADAVAÇE BOJE POZADINE
U Dreamweaveru se boja pozadine lako meça pomoñu specijalne palete boja za 

Web (engl. Web-safe color palette). Na toj paleti ima 216 boja koje jednako izgledaju 

u Windowsu i na Macintoshu. U ovoj veæbi, pristupiñete joj iz okvira za dijalog 

Page Properties i promeniti boju pozadine dokumenta introduction.htm.

s a v e t 1
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1)  Izaberite Modify › Page Properties. Sa liste Category odaberite stavku 

Appearance.

Okvir za dijalog Page Properties moæete da otvorite i pomoñu kombinacije 
tastera Ctrl+J (Windows), odnosno Command+J (Macintosh).

Otvoriñe se ekran Appearance okvira za dijalog Page Properties. U çemu 

nema podrazumevanih opcija, premda je u Dreamweaveru podrazumevana boja 

pozadine u prozoru dokumenta bela. Ako ne zadate boju pozadine, strana ñe se 

prikazati s podrazumevanom bojom pozadine koja je definisana u åitaåu kori-

snika. Poãto se podrazumevane vrednosti za åitaåe razlikuju, preporuåujemo da 

uvek definiãete boju pozadine strane.

2)  Pritisnite poàe sa uzorkom boje pored opcije Background Color. Prikazañe 

se paleta boja, a pokazivaå miãa pretvoriñe se u pipetu. Dovedite pipetu iznad 

uzorka boje na paleti.

Pipetom moæete da birate boju pozadine i tako ãto ñete u prozoru dokumenta 
uzimati “uzorak” boje sa tekstova i slika.

s a v e t 1
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Primetiñete da se heksadecimalne ãifre boja prikazuju na vrhu palete dok 

miãem prelazite preko uzoraka. Boja se u HTML-u definiãe heksadecimalnim bro-

jem koji opisuje RGB vrednost: koliåinu crvene, zelene i plave komponente. Hek-

sadecimalni sistem ima bazu od 16 cifara, a za çihovo oznaåavaçe koristi brojke  

0–9 i slova A–F. Od ãest cifara koje se u HTML-u koriste za opis boje, prve dve 

oznaåavaju koliåinu crvene komponente, druge dve koliåinu zelene, a posledçe 

dve – plave komponente. Na primer, broj #00FF00 oznaåava boju koja nema 

crvenu komponentu (na prva dva mesta su nule), ima jaku zelenu komponentu 

(FF oznaåava maksimalnu koliåinu zelene komponente, jer je F najveña cifra u 

heksadecimalnom brojnom sistemu), i uopãte nema plavu komponentu; boja 

#000000 nema ni crvene, ni zelene, ni plave komponente – to je crna. Nasuprot 

tome, #FFFFFF oznaåava maksimalne vrednosti crvene, zelene i plave kompo-

nente koje se kombinuju da bi prikazale belu boju na ekranu. Ne zaboravite – 

monitori koriste svetlost za prikazivaçe boja koje vidite. Svojstva boje svetlosti 

(koja se zasniva na aditivnom sistemu) razlikuju se od svojstava pigmenata koji se 

koriste u ãtampanim medijima (a koji su zasnovani na subtraktivnom sistemu).

Ako hoñete veñi izbor boja, pritisnite strelicu u gorçem desnom uglu 
prozoråiña s uzorcima boja, i u meniju koji se otvori izaberite paletu boja. Imajte u vidu 
da ostale palete nisu ograniåene na boje nameçene Webu, koje jednako izgledaju na svim 
platformama.

3)  Pritisnite uzorak bledosmeœe boje s heksadecimalnim kodom #CCCC99.

Time ste izabrali bledosmeœu boju za pozadinu strane. Umesto da birate boju 

pipetom, mogli ste isto tako da upiãete heksadecimalni kôd neposredno u poàe 

pored uzorka boje.

4)  Pritisnite dugme OK da biste zatvorili okvir za dijalog Page Properties i vratili 

se u dokument. Snimite datoteku.

Kada pritisnete dugme Apply primeniñete sve izabrane parametre, a okvir za 
dijalog Page Properties ostañe otvoren.

Pozadinska boja strane sada je svetlosmeœa boja koju ste izabrali u okviru za 

dijalog Page Properties.

ZADAVAÇE ÅITAÅA WEBA 
Tokom razvoja Web strana morañete stalno da proveravate kako vaã rad izgleda u 

razliåitim åitaåima, kao ãto su Internet Explorer i Netscape. Ono ãto vidite u pro-

zoru Dreamweavera samo je pribliæno jednako stvarnom izgledu prezentacije. 

Svaki åitaå prikazuje Web strane na razliåit naåin, i mada su neke od tih razlika 

n a p o m e n a
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neznatne, druge su veoma znaåajne. Primetiñete razlike åak i izmeœu prikaza 

koje daju razliåite verzije istog åitaåa. Ãto viãe budete proveravali izgled prezen-

tacije u raznim åitaåima Weba i operativnim sistemima i pravili odgovarajuñe 

izmene, biñete sigurniji da ñe posetioci Web lokacije çene strane videti kao ãto 

ste zamislili. Kartica Preferences u Dreamweaveru sluæi za zadavaçe åitaåa u 

kojima ñete proveravati izgled strana prezentacije. Da biste ubrzali proveru, 

zadajte prvi i drugi podrazumevan åitaå i za svaki definiãite preåicu s tastature.

1)  Odaberite File › Preview in Browser › Edit Browser List.

Otvoriñe se okvir za dijalog Preferences u kom ñe biti prikazan ekran Preview in 

Browser. Dreamweaver ñe moæda automatski prikazati jedan ili viãe åitaåa koji su 

instalirani na vaãem raåunaru.

U Windowsu, Internet Explorer u listi moæe biti prikazan kao 
iexplore.

Kada pritisnte ime åitaåa u listi, poàa za potvrdu ispod liste pokazuju da li je to 

primarni (engl. primary) ili sekundarni (engl. secondary) åitaå. Ukoliko na raåu-

naru imate joã neki åitaå, koji nije definisan ni kao primarni ni kao sekundarni, 

nijedno poàe ispod liste neñe biti potvrœeno.

n a p o m e n a
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Okvir za dijalog Preview in Browser moæete otvoriti i tako ãto ñete odabrati 
Edit > Preferences (Windows), odnosno Dreamweaver > Preferences (Macintosh), pa iza-
brati stavku Preview in Browser sa liste Category na levoj strani okvira za dijalog. Moæete 
koristiti i preåice s tastature Ctrl+U (Windows), odnosno Command+U (Macintosh).

2)  Pritisnite dugme sa znakom plus (+) da biste listi dodali joã jedan åitaå.

Kada se pojavi okvir za dijalog, pronaœite i izaberite åitaå Weba na svom disku. 

Potvrdite poàe Primary Browser ako hoñete da se taj åitaå otvori pritiskom na 

taster F12 kada pregledate stranice. Potvrdite poàe Secondary Browser ako 

hoñete da u tom åitaåu pregledate strane kad pritisnete Ctrl+F12 (Windows), 

odnosno Control+F12 (Macintosh). (Strane na kojima ñete raditi u ovoj kçizi 

åesto ñete pregledati u åitaåu Weba, pa ñe vam ove preåice uãtedeti dosta vre-

mena.)

Funkcijski tasteri moraju biti ukàuåeni da biste za otvaraçe strana u 
åitaåu mogli da koristite preåice s tastature. Oni su obiåno podrazumevano ukàuåeni, ali 
ako ne funkcioniãu, proverite parametre operativnog sistema. Ukoliko funkcijski tasteri 
obavàaju sistemske funkcije, moæda ñete morati da pritisnete taster Fn da biste ih koristili 
za Dreamweaver – ili da izmenite parametre sistema.

Da biste sa liste uklonili åitaå, izaberite çegovo ime na listi i pritisnite dugme 

sa znakom minus.

Kad hoñete da promenite åitaå, izaberite çegovo ime na listi, pa pritisnite 

dugme Edit i odaberite drugi åitaå.

3)  Neka opcija Preview Using Temporary File ostane potvrœena. Kada zavrãite 

dodavaçe åitaåa, pritisnite OK.

Opcija Preview Using Temporary File podrazumevano je iskàuåena. Kada je 

potvrdite, Dreamweaver ñe praviti privremene datoteke prilikom pregledaça 

strana u åitaåu.

4)  Pritisnite F12 da biste pogledali stranu u primarnom åitaåu.

Moæete odabrati i File > Preview in Browser, pa iz menija izabrati åitaå koji 
hoñete da koristite. Paleta Document sadræi dugme Preview/Debug in Browser; pritisnite 
ga da biste otvorili meni i izabrali åitaå u kojem hoñete da pogledate stranu.

s a v e t 1
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Åitaå koji ste odabrali kao primarni u okviru za dijalog Preview in Browser 

postaje aktivan i prikazuje datoteku introduction.htm u prozoru åitaåa. Na 

naslovnoj traci åitaåa nalazi se naslov Lights of the Coast.

U åitaåu Weba se trenutno vidi prazna strana sa svetlobraon pozadinom. Sada 

moæete da poånete s ubacivaçem sadræaja. U sledeñoj lekciji ñete dodati tekst.

Ako na poåetku lekcije na uvodnoj strani niste pritisnuli dugme Don’t 
Show Again, uvodna strana ñe se ponovo pojaviti kada zatvorite sve otvorene dokumente.

ÃTA STE NAUÅILI
U ovoj lekciji ste:

• otvorili Dreamweaver (strane 10–11)

• pripremili se za izradu Web prezentacije, uspostavili lokalnu prezentaciju 

i definisali osnovni lokalni direktorijum (strane 12–21)

• napravili novu stranu i snimili dokument poãtujuñi odgovarajuñe konvencije 

o imenovaçu (strane 21–24 )

• upoznali se s Dreamweaverovom trakom Insert i panoom Properties, prozo-

rom dokumenta i drugim alatkama, prozorima i panoima (strane 25–30)

• dali strani naslov (strane 30–31)

• odabrali boju pozadine za Web (strane 31–33)

• izabrali åitaåe Weba koje ñete koristiti za proveru i koristili preåice s tasta-

ture za proveru strane (strane 33–36).

dugme preview/debug in browser
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